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Welcome!

For business and professional users, the EPSON Stylus® C80 printer introduces a new 
era of superior color desktop printing. With resolutions up to 2880 × 720 dpi, it 
delivers ultra sharp text and clear, vibrant colors at extremely fast print speeds—up to 
20 ppm for black text printing. 

But what makes the EPSON Stylus C80 truly stand out from the competition is 
EPSON’s exclusive DuraBrite™ ink technology. This quick-drying, super-penetrating 
ink is both water-resistant and fade-resistant. When properly cared for, your prints 
can last for many years.

The light resistance of prints is rated up to seventy years with EPSON 
Archival™ Matte Paper. This rating is based on accelerated testing of 
prints on special media, displayed indoors, under glass. Actual print 
stability will vary according to image, display conditions, light 
intensity, humidity, and atmospheric conditions. EPSON does not 
guarantee the longevity of prints. Lightfastness ratings do not 
estimate the durability of the paper itself. For maximum print life, 
display all prints under glass or lamination or properly store them.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. This book 
contains system requirements, important safety information, and instructions on:

� viewing your on-screen Reference Guide 

� printing with Windows® or on a Macintosh® 

� maintaining the printer

� solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, 
see your on-screen Reference Guide, as described on page 2. 



2

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Viewing Your On-Screen Reference Guide

Your printer CD-ROM includes an on-screen Reference Guide. It is in HTML 
format, so you need a browser—such as Microsoft® Internet Explorer 3.0 or later or 
Netscape Navigator™ 3.0 or later—to view it. If you are using a different browser, the 
pages may not display correctly. (A browser is not included on the printer software 
CD-ROM.)

You can view this Reference Guide from the CD-ROM or copy it to your hard drive 
and view it from there. Follow these steps:

1. Insert your printer software CD-ROM.

2. Windows: Double-click My Computer (for Windows XP, click Start first), 
double-click your  CD-ROM or DVD drive icon, then double-click the  
EPSON icon. 

Macintosh: Double-click the  EPSON icon on your desktop. Then 
double-click the  EPSON icon in your CD-ROM window.

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.
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The Main Menu appears:

3. Click View Reference Guide. 
You see this screen.

4. You can either view the manual 
from the CD-ROM (View 
Reference Guide) or copy the 
manual to your hard drive (Install 
Reference Guide) and view it 
from there. For details on viewing 
the manual, see the next section.

If you copied the manual to your hard 
drive, you can access it at any time, as follows:

Windows: Select Start > Programs (or All Programs) > EPSON, and click ES C80 
Guide. 

Macintosh: Open the EPSON STYLUS C80 folder and double-click View Reference 
Guide.
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When you first open the Reference Guide, you see this screen:

Click a topic on the left to expand the table of contents. After expanding the table of 
contents, you can click on the topic you want to view.

If there’s a right arrow , click it to view subtopics, then click on a topic to go to it.

Click the down arrow to close a subtopic list.

If you see an icon for a graphic when viewing your Reference Guide 
in Netscape Navigator, click the Reload button to load the graphic.

Click here to 
expand the 
table of 
contents

Closed 
list, click 
to expand

Click to go 
to topic
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Printing from Start to Finish

Here’s what to do to print a basic document—such as a photograph or newsletter—
from loading the paper to selecting print settings to controlling the print job. Follow 
the instructions in these sections:

� “Loading Paper” on page 6

� “Printing with Windows” on page 7

� “Printing on a Macintosh” on page 11

� “Selecting the Correct Media Type” on page 14

If you’re already familiar with EPSON ink jet printing, you can skip to these sections:

� “Printing On Envelopes” on page 15

� “Using PhotoEnhance, Custom, and Advanced Settings” on page 16

� “Printing on Both Sides of the Paper” on page 20
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Loading Paper

You can load up to 150 sheets of plain paper in your printer’s sheet feeder, as long as 
your stack does not come above the arrow on the printer’s left edge guide.

Fan the stack of paper before loading it. Then place your paper against the right edge 
of the sheet feeder and slide the left edge guide against the paper. (Don’t push the 
paper deeper into the feeder.) Make sure the paper lies flat against the paper support.

Follow these guidelines when loading paper:

� Fan paper before loading it and make sure it lies flat against the paper support.

� Load the printable side face up. It’s usually whiter or brighter than the other side.

� Always load the short edge first, even when printing in landscape mode.

� Load letterhead or preprinted paper into the printer top edge first.

� Don’t load paper above the arrow on the left edge guide.

� If you experience paper feeding problems, try loading fewer sheets.

For instructions on using special media, see your on-screen 
Reference Guide.

Slide the left edge 
guide against the 
paper

Don’t load paper 
above this arrow

Make sure the paper 
lies flat against the 
paper support
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Printing with Windows

This section describes the basic steps for printing with Windows. Make sure you have 
paper in the printer, as described on page 6. After you create your document in a 
software program, follow these steps to print:

1. From the File menu, click Print. You see your application’s Print dialog box (your 
dialog box may look different):

2. Make sure your EPSON Stylus C80 printer is selected.

3. Click the Properties button (Preferences button for Windows XP). If you see a 
Setup, Printer, or Options button, click it. Then click Properties (or 
Preferences) on the next screen.

If you click the print icon on your application’s tool bar instead of 
selecting Print from the File menu, you may not get the option to 
change the printer software settings before printing.

You see the Main menu of your printer settings dialog box.

Click here to open 
your printer software

Select your printer here
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The most important thing to remember is to set the correct Media Type for the 
paper you’re using. The printer automatically adjusts other settings to optimize 
the results for your media.

4. Make the following settings:

� Choose the Media Type for your paper (click the 
arrow to display the Media Type list). If you’re 
not sure which setting to select, see page 14. 

� For Ink, select Color to print a color document, 
or Black to print a grayscale or black text 
document.

� Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

� Set the slider in the Mode box to Quality or Speed to select high-quality or 
faster printing. (The slider may not be available for your Media Type.)

Select higher-quality or faster 
printing

Select the type of paper you loaded

Select Automatic mode

Select the ink color

Click OK



9

5. Click the Paper tab at the top of the 
window if you need to change the paper 
size, number of copies, page orientation, 
or printable area.

6. Click the Layout tab if you want to reduce 
or enlarge your printed image, print 
multiple layouts, or add a watermark.

7. Click OK to return to the Print dialog box.

8. Click OK (or Print) to begin printing.

For more information about printer settings, click the Help button. 
You can also right-click any item on the screen and then click What’s 
This?.

After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left.

Click to cancel printing

Click to pause or resume 
printing

Shows ink levels 
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For more information on printing—for example, using advanced printer settings, 
previewing your printout, or adding a watermark—see your on-screen Reference Guide 
(described on page 2) or your printer software online help.

Selecting the Settings You Use Most Often

Your printer settings apply only to the application you’re currently using. If you 
usually print one type of document in different applications—for example, color 
flyers on letter-size paper—you can change the default printer settings for all your 
programs.

1. Right-click the  printer icon on your taskbar (in the lower right corner of your 
screen.

2. Select Printer Settings. You see the Main menu of your printer settings dialog 
box, as shown on page 8.

3. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

Remember that you can always change the settings in your program when you want to 
print different types of documents. 

Another way to select your most frequently used settings quickly is to save them as a 
group; see your on-screen Reference Guide for details.
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Printing on a Macintosh

This section describes the basic steps for printing on a Macintosh. Make sure you have 
paper in the printer, as described on page 6. After you create your document in a 
software program, follow these steps to print:

1. From the File menu, click Page Setup. You see your printer software’s page setup 
dialog box (your dialog box may look slightly different):

2. Make sure C80 Series is selected. If not, you need to select your printer in the 
Chooser, as described on the Start Here sheet.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

Verify your printer model here Select your Paper Size, Orientation, 
and Printable Area settings

Click OK
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4. From the File menu, click Print. You see the main printer settings dialog box 
(your dialog box may look slightly different).

The most important thing to remember is to set the correct Media Type for the 
paper you’re using. The printer automatically adjusts other settings to optimize 
the results for your media.

5. Make the following settings:

� Choose the Media Type for your paper (click 
the arrow to display the Media Type list). If 
you’re not sure which setting to select, see 
page 14. 

� For Ink, select Color to print a color document. 
To print a grayscale or black text document, 
click Black.

� Set the Mode to Automatic. It’s the easiest way to get good printing results on 
all types of paper.

� Set the slider in the Mode box to Quality or Speed to select higher quality or 
faster printing. (The slider may not be available for your Media Type.)

Select higher-quality or faster printing

Select the type 
of paper you 
loaded

Select Automatic mode

Select the 
ink color
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6. You can also do the following:

� Click  to reduce or enlarge your image, print multiple layouts, or add a 
watermark.

� Click to control background printing.

� Click to change the Print button to Preview. You can then click it to 
preview your printout.

� Click to check your ink levels. If the printer’s 

 

H ink out light is flashing or 
on, check to see if one of your ink cartridges is low or empty.

7. Click Print to start printing. 

If you turned on background printing, you can select EPSON Monitor3 from the 
Macintosh Application menu to see this dialog box:

If you’re not using background printing and you need to 
cancel the current print job, hold down the 

 

J key and press 
the . (period) key.

Click to cancel printingClick to pause printing

Click to restart your print job

Click on the 
current print job
or
a waiting print 
job . . .

Then click here to 
view details of the 
selected print job 
and control print 
job priorities

Click to check
ink levels
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For more information on printing—for example, using advanced settings, previewing 
your printout, or adding a watermark—see your on-screen Reference Guide (described 
on page 2). 

Selecting the Correct Media Type

Your printer automatically adjusts itself for the type of 
paper you select in your printer software. That’s why 
the Media Type setting is so important. It tells your 
printer what kind of paper you’re using and adjusts the 
ink coverage accordingly. 

Here are the settings you should choose for your paper:

For this paper . . . Select this Media Type setting . . .

Plain paper sheets or envelopes Plain Paper

EPSON Premium Bright White Paper Bright White Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Premium Glossy Photo Paper Premium Glossy Photo Paper

EPSON Premium Semigloss Photo Paper Premium Semigloss Photo Paper

EPSON Matte Paper - Heavyweight Matte Paper - Heavyweight

EPSON Double-Sided Matte Paper Double-Sided Matte Paper

EPSON Archival Matte Paper Archival Matte Paper

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing On Envelopes

You can load up to 15 envelopes at a time. Follow these steps to print on envelopes:

1. Load the envelopes short edge first against the right edge of the sheet feeder. The 
printable side should be up, and the flap side should be down and on the left. 
Slide the left edge guide against them. 

2. Open the printer cover and set your printer’s thickness lever to the 

 

^ position. 
(Remember to move the thickness lever back to the 

 

m position when you’re done.) 

3. Make the following settings in your printer software: 

� For Media Type, select Plain Paper

� For Orientation, select Landscape

� For Paper Size, select Envelope #10 4 1/8 × 9 1/2 in (Windows) or 
Envelope #10 (Macintosh)

See page 7 (Windows) or page 11 (Macintosh) for more information about making 
printer software settings.

Make sure 
the flap side 
is on the left

Load with the printable 
side up and the flap side 
down
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Using PhotoEnhance, Custom, and 
Advanced Settings 

When you’re printing special projects, you can customize your printer software 
settings, as described in these sections:

� “Enhancing Photos” below

� “Using Custom Project Types” on page 17

� “Using Advanced Settings” on page 18

For additional information on these settings, see the on-screen Reference Guide, as 
described on page 2.

Enhancing Photos

The printer software includes PhotoEnhance™ options that adjust image brightness 
and contrast to improve the appearance of low-resolution or improperly exposed 
photos. You can also use PhotoEnhance to add special effects. 

If you’re printing high-resolution images, you may want to use the 
Automatic setting instead, as described on page 8 (Windows) or page 12 
(Macintosh).

PhotoEnhance does not affect your original image; it only affects your 
printout. Printing with PhotoEnhance may take longer on some systems.

To use PhotoEnhance, you must select Color ink; you cannot turn on 
PhotoEnhance with Black ink selected.
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To use PhotoEnhance, set the Mode option to PhotoEnhance in your printer settings 
dialog box.

If your photo was taken with a digital camera, select Digital Camera Correction to 
give your printed images the appearance of photos taken with a film camera. 

For more fine-tuning, select from a list of specialized settings for photographs, such as 
People or Nature, or select special filters, such as Soft Focus or a Sepia tint. 

Using Custom Project Types

Your printer software includes custom project types with preset printing options. This 
lets you quickly select the best settings for your type of document, or select a 
color-matching method for your project. 

To access the project types, click Custom, then click the Custom Settings list to 
open it. 

Windows

Macintosh

Windows

Macintosh
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Select one of these settings:

� Text (Windows) or Text/Graph (Macintosh): For printing graphics-intensive 
documents like presentations with charts and graphs.

� Economy: For printing rough drafts of text on plain paper. Saves ink. 

� ICM (Image Color Matching; Windows only): For matching colors as closely as 
possible with ICM-compatible monitors or scanners. 

� sRGB (standard Red Green Blue; recommended only with Windows 98, 
Windows Me, Windows 2000, or Windows XP): For color matching with other 
sRGB devices, or for images designed for the Web. See your Windows help for 
details.

� ColorSync® (Macintosh only): For matching colors to your screen as closely as 
possible, when used in conjunction with ColorSync-compatible devices and 
applications.

You can also fine-tune these settings on the Advanced dialog box to fit 
your individual needs, as described in the next section.

Using Advanced Settings

For maximum control over your project, you can customize your print settings—such 
as Print Quality and Gamma—and use special effects. 

You can also improve the clarity of low-resolution images (under 100 dpi) by selecting 
the Edge Smoothing box on the Advanced dialog box.

This setting is recommended for printing documents in PDF format, 
images downloaded from the Web, or posters that have been 
enlarged. For digital camera images, use Digital Camera Correction 
instead.

Edge Smoothing does not affect high resolution images.
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To access the Advanced dialog box, set the Mode option to Custom in your printer 
settings dialog box. Then click the Advanced button that appears.

You see the Advanced dialog box:

After you customize your print settings on the Advanced dialog box, you can save 
them as a group and reuse them whenever you print a similar project. See your 
on-screen Reference Guide (as described on page 2) for instructions.

For more information about all the advanced settings, click the Help or button.

Windows

Macintosh

Macintosh

Windows
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Printing on Both Sides of the Paper

You can print on both sides of the page with your printer’s Double-Sided Printing 
setting. This section includes instructions for standard double-sided printing. For 
information about how to create single-fold booklets, see your electronic Reference 
Guide.

For best results, use EPSON Premium Bright White Paper or Double-Sided Matte 
Paper. However, you can also get excellent results using plain paper.

Don’t print on both sides of paper that is designed for single-sided 
printing, such as EPSON Premium Glossy Photo Paper, Premium 
Semigloss Photo Paper, or Photo Quality Ink Jet Paper. Your print 
will be oversaturated.

Double-sided printing is not available when the printer is shared over 
a network.

Follow these steps to print on both sides of the page:

1. Load plain paper or another double-sided media in your printer. 

� For most media, you can print up to 60 pages at a time on 30 sheets of paper.

� For Double-Sided Matte Paper, load only one sheet at a time.

Print longer documents in sections. For example, if you’re printing a 
175-page document, print it in three sections of 60 pages (30 
sheets), 60 pages (30 sheets), and 55 pages (28 sheets). Select the 
following page ranges in your print dialog box: 1–60, 61–120, 
121–175.

If your long document has an odd number of pages, print even 
numbers of pages for the first sections and print an odd number for 
the last section. That way, if you have a blank page it will appear at 
the end of your document.
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2. Windows: Open the printer software from your application. (See page 7 for 
details.) Choose the Media Type for your paper from the Media Type list. Then 
click the Layout tab and choose Double-Sided Printing.

Macintosh: Select File > Page Setup from your application to open your printer 
software’s page setup dialog box. Then choose Double-Sided Printing.

3. Click OK to save your settings.

4. Start printing. 

Windows: Click OK (or Print) in your application’s Print dialog box.

Macintosh: Select File > Print. Select the Media Type for your paper from the 
Media Type list in the printer settings dialog box. Then click Print.

The printer prints the odd-numbered page(s), starting with page 1.

Macintosh

Windows

Click here
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When the odd-numbered page(s) have 
printed, you see an alert on your screen 
telling you to reload paper.

5. Leave the printed sheet(s) in your output 
tray for a moment to let them dry:

� For most documents, let your printout dry for 30 seconds.

� For graphics-intensive documents, let your printout dry for 60 seconds.

6. Remove the printed sheet(s) from the output tray. Without changing the order of 
the pages, reload the paper with the printed side down and the top edge first, as 
shown in the illustrations on the screen. 

7. Click Resume to print on the other side of the page.

If you don’t see the alert 
on your Macintosh, select 
EPSON Monitor3 from the 
Macintosh Application 
menu.
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Maintaining Your Printer

This section describes maintenance procedures to keep your printer working at its best 
and preparation steps for moving your printer. Follow the instructions here for: 

� “Cleaning the Print Head” (below)

� “Replacing an Ink Cartridge” on page 25

� “Aligning the Print Head” on page 34

� “Cleaning the Printer” on page 36

� “Transporting the Printer” on page 37

For more details, see your on-screen Reference Guide, as described on page 2.

Cleaning the Print Head

If your printed image is unexpectedly light, or dots or lines are missing from the 
image, you may need to clean the print head. This unclogs the nozzles so they can 
deliver ink properly. Cleaning the print head uses ink, so clean it only if print quality 
declines. 

This section explains how to clean the print head using the printer’s Head Cleaning 
utility, which is the recommended method. Your printer must be connected directly 
to your computer, not on a network, to use the Head Cleaning utility.

You can also clean the print head using the control panel buttons. See your on-screen 
Reference Guide for details.

When you don’t turn on your printer for a long time, the print quality 
can decline. It’s a good idea to turn on your printer at least once a 
month to maintain good print quality.

If your paper comes with a cleaning sheet, don’t use it with your 
printer; it may jam inside the printer.
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Follow these steps to run the Head Cleaning utility:

1. Make sure the printer is turned on but not printing. 

The 

 

P power light should be on, but not flashing. Neither of the other lights 
should be flashing or on.

You can’t clean the print head if the 

 

H ink out light is flashing or on. 
Replace the appropriate ink cartridge instead.

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning. 

Macintosh: Open your application’s File menu and choose Page Setup or Print. 
Click the Utility button, then click the  Head Cleaning button.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 30 seconds, during which the printer makes some noise and the 

 

Ppower 
light flashes. 

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.

4. When the 

 

Ppower light stops flashing, run a nozzle check to confirm that the 
print head nozzles are clean.

Make sure plain paper is loaded in the printer and click Print nozzle check 
pattern (Windows) or Confirmation (Macintosh). Follow the instructions on the 
screen to print a nozzle check pattern.

5. If the nozzle check pattern has no gaps in its lines, click Finish.

If the pattern has any gaps, click Clean to clean the print head again. If you don’t 
see any improvement after cleaning three or four times, check the solutions in 
“Print Quality Problems” on page 46.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look something like this:

Each staggered horizontal and straight vertical line should be complete, with no gaps 
in the dot pattern. If your printout looks okay, you’re done. 

If there are gaps in the lines, clean the print head again; see page 23 for instructions.

Replacing an Ink Cartridge

When the 

 

H ink out light is flashing, one of your ink cartridges is low on ink. This is a 
good time to make sure you have a new ink cartridge. When the 

 

H ink out light stays 
on, an ink cartridge is empty and you need to replace it.

You cannot print if any of the ink cartridges are empty. Leave the 
empty cartridge installed in the printer until you have obtained a 
replacement; otherwise the ink remaining in the print head nozzles 
may dry out.

If the 

 

m paper out or 

 

P power light are also flashing or on, check the 
table on page 41. You may have a paper jam or another problem.

gaps in nozzle check pattern

gaps in nozzle check pattern
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When an ink cartridge has been installed in your printer for more than six months, 
you may need to replace it if you notice that your printouts don’t look as good as they 
used to. If print quality doesn’t improve after cleaning and aligning the print head, 
you can replace the cartridge even if the 

 

H ink out light isn’t flashing. 

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

� Black: T032120

� Cyan: T032220

� Magenta: T032320

� Yellow: T032420

To ensure good results, use genuine EPSON ink cartridges and do 
not refill them. Other products may cause damage to your printer not 
covered by EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call the EPSON Store  at 
(800) 873-7766. You can also visit the EPSON Store at www.epsonstore.com (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer referral.

SM
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Checking Your Ink Supply

To check your ink supply, do one of the following:

� Windows: Double-click the  printer icon 
on your taskbar (in the lower right corner of 
your screen). You see a window like the one 
on the right showing ink levels:

You can also double-click the  Ink 
Monitor icon on the taskbar. The window 
that appears lets you check ink levels and 
also order cartridges online. Just click the 
Buy Now button to launch your web 
browser.

� Macintosh: Open your application’s File 
menu and choose Print. Then click the

 ink icon. You see a window like the one 
on the right:



28

Ink Cartridge Precautions

Replacing an Empty or Low Ink Cartridge

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session.

Follow these steps to replace ink cartridges when the 

 

H ink out light is flashing or on:

1. Make sure the printer is turned on and not printing. The 

 

P power light should be 
on, but not flashing.

2. Lower the output tray and open the printer cover.

Don’t remove the cartridge label, or ink will leak.

Don’t remove the green IC chip from the cartridge. Installing a 
cartridge without an IC chip can damage the printer. Also, don’t touch 
the green IC chip. This can damage the ink cartridge.

If you remove an ink cartridge 
temporarily, protect the ink 
supply port on the bottom of the 
cartridge from dirt and dust. 
Place it in a small box, or, if you 
have the original packaging, 
return it to its own box.

Store ink cartridges in the same 
environment as the printer. 
Stand the cartridges upright, as 
shown (the label identifying the 
color should be on top).

Don’t touch this part
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3. Press the 

 

H ink cartridge replacement 
button. The print head moves to the 
left, and the cartridge that needs to be 
replaced stops under the 

 

_ mark. The 

 

P power light also begins to flash. 

4. Press the 

 

H ink cartridge replacement 
button again. 

� If more than one ink cartridge is empty, the next cartridge moves under the 

 

_ 
mark. This happens after you press the 

 

H ink cartridge replacement button for 
every ink cartridge that needs to be replaced. 

� If all the empty cartridges have 
been identified, the print head 
moves to the ink cartridge 
replacement position.

To avoid damaging the 
printer, never move 
the print head by hand.

Don’t press the H ink 
cartridge replacement 
button for more than 
three seconds, or the 
printer will start to clean 
the print head.
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5. Pinch the front and back tabs of the 
empty cartridge as you lift it out of the 
printer. Don’t take the used cartridge 
apart or try to refill it.

6. Before you remove the new cartridge 
from its package, shake it four or five 
times.

7. Remove the cartridge from its 
package and lower it into the 
cartridge holder. Push down 
gently until the cartridge clicks 
into place.

8. Repeat steps 5 through 7 for 
each cartridge that you need to 
replace.

If ink gets on your hands, 
wash them thoroughly 
with soap and water. If ink 
gets into your eyes, flush 
them immediately with 
water.
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9. Close the printer cover and press the 

 

H ink cartridge replacement button. The 
printer moves the print head and begins charging the ink delivery system.

The 

 

P power light flashes and the printer makes noise. Charging takes about one 
minute. When it’s finished, the 

 

P power light stops flashing and stays on.

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.

Replacing a Cartridge When Print Quality Declines

Even if the 

 

H ink out light isn’t flashing or on, you may need to replace an ink 
cartridge if it’s been installed in your printer for more than six months and print 
quality declines. If print quality doesn’t improve after cleaning and aligning the print 
head, you can replace the cartridge(s) causing the problem. 

Follow these steps to replace ink cartridges when print quality declines:

1. Print a nozzle check pattern to determine which cartridges need to be replaced:

Windows: Right-click the  printer icon on the Windows taskbar, and then 
click Nozzle Check.

Macintosh: Open your application’s File menu and choose Print. Then click the 
 Utility button. On the Utility menu, click the Nozzle Check button.

2. Follow the instructions on the screen to print the nozzle check pattern. Then 
examine the pattern for gaps in the lines. You only need to replace those colors 
whose lines show gaps.

3. Make sure you have the correct replacement cartridges.

You must have the new ink cartridges before you continue. Once 
you start the ink cartridge replacement procedure, you must 
complete all the steps in one session.

4. Lower the output tray and open the printer cover.
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5. Press the 

 

H ink cartridge replacement 
button. The print head moves to the 
ink cartridge replacement position, 
and the 

 

P power light begins to flash. 

6. Pinch the front and back tabs of the 
cartridge as you lift it out of the printer. 
Don’t take the used cartridge apart or 
try to refill it.

Don’t press the H ink 
cartridge replacement 
button for more than 
three seconds, or the 
printer will start to clean 
the print head.

To avoid damaging 
the printer, never 
move the print head 
by hand.

If ink gets on your hands, 
wash them thoroughly 
with soap and water. If 
ink gets into your eyes, 
flush them immediately 
with water.
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7. Before you remove the new cartridge 
from its package, shake it four or five 
times.

8. Remove the cartridge from its 
package and lower it into the 
cartridge holder. Push down gently 
until the new cartridge clicks into 
place.

9. Repeat steps 6 through 8 for each 
cartridge you want to replace.

10. Close the printer cover and press the 

 

H ink cartridge replacement button. The 
printer moves the print head and begins charging the ink delivery system.

The 

 

P power light flashes and the printer makes noise. Charging takes about one 
minute. When it’s finished, the 

 

P power light stops flashing and stays on.

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. Your printer must be connected directly to your computer, not on a network, to 
use the Print Head Alignment utility.

Load plain paper that’s at least 8.27 inches (210 mm) wide to prevent 
ink from spraying inside the printer and smudging your printouts.

1. Make sure the printer is on but not printing, and letter-size plain paper is loaded.

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

Macintosh: Open your application’s File menu and choose Page Setup or Print. 
Then click the  Utility button. On the Utility menu, click the  Print Head 
Alignment button.

3. Follow the instructions on the 
screen to print a vertical alignment 
test page. You see this window:
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4. Look at the first group of lines on the 
printout. Select the the line with the 
cleanest, straightest edges and enter its 
number in box #1 on the screen. 

5. Select the best line for each of the other 
groups of lines, and enter its number in 
the appropriate box. 

6. Do one of the following:

� If the middle line (number 8) in 
each group is the best, your print 
head’s vertical alignment is correct. 
Click Next to continue.

� If you select a number other than 
8 for any of the groups, click 
Realignment and follow the instructions on the screen to print another 
vertical alignment test page. Repeat steps 4 through 6 until number 8 is the 
best line for each of the groups. Then click Next to continue.

7. Follow the instructions on the screen to print a horizontal alignment test page. 
You see seven pairs of gray rectangles on the printout.

8. Select the pattern with the least white or black banding where the rectangles meet 
and enter the number on the screen.

9. Do one of the following:

� If pattern number 4 is the best choice, your print head’s horizontal alignment 
is correct. Click Finish.

� If you enter any number but 4, click Realignment and follow the instructions 
to print another test page. Repeat steps 8 and 9 until pattern number 4 is the 
best choice. Then click Finish.

Select the line in the first pattern with 
the cleanest, straightest edges. . .

and enter its number in the 
corresponding box on screen
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer and wait for the 

 

Ppower light to go out.

2. Unplug the power cord and disconnect it from the printer. 

3. Disconnect the printer cable from the printer.

4. Remove all the paper from the sheet feeder.

5. Clean the exterior of the printer with a soft, damp cloth. Keep the printer cover 
closed to prevent water from getting inside.

6. If ink leaks inside the printer, carefully wipe it off with a damp cloth.

Don’t touch the gears inside the printer.

Make sure you use a soft cloth to clean the printer’s lid; otherwise 
you may scratch it. Don’t use a rough cloth, and never use a hard or 
abrasive brush to clean any part of the printer case.

Never use alcohol or thinner for cleaning; they can damage the 
printer components and case.

Don’t get water on the printer components, and don’t spray 
lubricants or oils inside the printer.

Don’t use any cleaning sheets included with special media; they may 
jam inside the printer.

If ink leaks inside, 
wipe here with a 
damp, lint-free cloth
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. Follow these steps:

To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 5 after installing the printer 
in its new location.

1. Turn on the printer and wait until the print head locks in the far right position. 
Then press the 

 

P power button to turn the printer off.

2. Unplug the power cord from the electrical outlet and disconnect it from the 
printer.

3. Disconnect the printer cable from the printer.

4. Remove any paper from the printer and remove the paper support.

5. Open the printer cover. Secure 
the ink cartridge holder to the 
printer with tape as shown, 
then close the printer cover.

6. Push in the output tray 
extensions and close the tray.

7. Repack the printer and 
attachments in the original box 
using the protective materials 
that came with it. See the Start 
Here sheet for details.

Be sure to keep the printer level as 
you move it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 23); if 
output is misaligned, align the print head (see page 34). 

Tape the ink 
cartridge holder to 
the printer case
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Problem Solving

This section gives you the basics for diagnosing and solving printer problems. 

� First see “Diagnosing Printer Problems” on page 41 to help determine what the 
cause of the problem may be. 

� Then see “Problems and Solutions” on page 44 for solutions to common setup 
and printing problems.

It’s a good idea to check EPSON’s support web site periodically for 
possible updates to your printer driver. Visit http://support.epson.com 
and check the section for your product to see if there is a new driver 
available, free of charge, for downloading to your computer. Download 
instructions are posted for your convenience.
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Printer Parts

Paper support

Printer cover

Output tray extensions

Output tray

Left edge guide

Right edge 
guide

Ink cartridge holder 
(not removable)

Paper thickness lever Control panel
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Diagnosing Printer Problems

You can diagnose some problems by checking the printer’s control panel lights, as 
described in this section, or running a printer check, as described on page 43.

Checking the Control Panel Lights

Follow the guidelines below when you check the control panel lights:

 

P is on or 
flashing

The 

 

Ppower light is on when the printer is ready to print. It flashes 
when the printer is receiving a print job, charging ink, or cleaning the 
print head. It also flashes when the print head moves to the ink 
cartridge replacement position.

 

m is on The printer is out of paper. Load paper as described on page 6, and 
then press the 

 

m paper button to resume printing.

 

m is flashing and 

 

H is on
Paper has jammed in the printer. Press the 

 

m paper button to eject the 
jammed paper. If that doesn’t clear the error, open the printer cover 
and remove any paper inside, including torn pieces. Then load a new 
stack of paper and press the 

 

m paper button to resume printing.

 

H is flashing One of the ink cartridges is low on ink. Follow the instructions 
beginning on page 28 to replace the empty cartridge. If the 

 

H ink out 
light goes on after you’ve replaced a cartridge, you may have installed a 
cartridge your printer can’t use. Check the number on the ink cartridge 
package to make sure you’ve installed the correct cartridge.

Power buttonPaper buttonInk cartridge replacement button

Power 
light

Ink out light Paper out light
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H

 

 is on One of the ink cartridges is out of ink. Follow the instructions beginning 
on page 28 to replace the empty cartridge. If the 

 

H ink out light remains 
on after you’ve replaced a cartridge, you may have installed a cartridge 
your printer can’t use. Check the number on the cartridge package to 
make sure you’ve installed the correct cartridge.

 

P

 

 and 

 

m are 
flashing

Jammed paper may be blocking movement of the print head, or you 
may have an internal error. Turn off the printer, open the cover, and 
check for any jammed paper. Also, make sure you removed all the 
packing material, as described on the Start Here sheet. Then turn the 
printer back on. If the error isn’t cleared, contact your dealer or EPSON. 
See page 54 for contact information.

 

P and 

 

H are on An ink cartridge was installed incorrectly.

� If the print head is at the home position (at the far right as you face 
the printer), open the printer cover and press the 

 

H ink cartridge 
replacement button to move the cartridge holders to the 
replacement position. Remove and reinsert any cartridge that 
you’ve recently replaced. Make sure the cartridge clicks into place. 
Close the printer cover and press the 

 

H ink cartridge replacement 
button again to finish installation.

� If the cartridge holders are already in the replacement position, 
remove and reinsert the ink cartridge. Then press the 

 

H ink 
cartridge replacement button to finish installation.

 

P, 

 

m, and 

 

H are 
flashing

An unknown printer error has occurred. Turn the printer off and contact 
your dealer or EPSON as described on page 54.

 

P is off The printer is not receiving power. Try these solutions:

� Make sure the printer is turned on.

� Turn off the printer, plug in the power cord securely, and turn the 
printer on again.

� Make sure the outlet is working and is not controlled by a switch or 
timer. If in doubt, try another outlet.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. Follow these steps:

1. Make sure both the printer and computer are turned off. Then disconnect the 
interface cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Hold down the 

 

m paper button, then press and release the 

 

Ppower button. 
Continue holding down the 

 

m paper button until the 

 

Ppower light starts to 
flash, then release it.

The printer prints one page showing its ROM version number, ink counter, and a 
nozzle check pattern. Only the nozzle check pattern is shown below. (If the 
pattern has gaps in its dots, you need to clean the print head; see page 23.)

4. To end the check, turn the printer off after it prints the check page. Then 
reconnect the interface cable and turn on your printer and computer.

If the check page prints, the problem probably lies in your software settings, the 
interface cable, or your computer. Another possibility is that your printer software 
may not be installed correctly.

If the check page doesn’t print, you may have a problem with your printer. Try the 
suggestions in “Problems and Solutions” beginning on page 44. If nothing seems to 
work, contact your dealer or EPSON as described on page 54.
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Problems and Solutions

Here are some troubleshooting tips if you have any problems setting up your printer, 
installing software, or printing.

Problems Setting Up 
the Printer or Installing 
Software

The printer makes noise after ink 
cartridge installation.

� The first time you install ink 
cartridges, the printer must charge 
its ink delivery system for about 90 
seconds. Wait until charging 
finishes (the 

 

Ppower light stops 
flashing) before you turn off 
the printer or it may charge 
improperly and use excess ink the 
next time you turn it on. If the 
printer stops moving or making 
noise, but the 

 

P power light is still 
flashing after 5 minutes, turn off 
the printer. If the light is still 
flashing when you turn it back on, 
contact EPSON as described on 
page 54.

� Make sure no packing material 
remains in the printer. Turn off 
the printer, wait a moment, then 
turn it back on to clear the error.

You’re having problems installing 
the printer software.

� Make sure your printer is turned 
on and the printer cable is securely 
connected at both ends. Then 
carefully follow the installation 
instructions on the Start Here 
sheet. Also make sure your system 
meets the requirements beginning 
on page 55.

� Close your other applications, 
including any screen savers and 
virus protection software, and 
install again.

� For Windows NT or 2000, if you 
see an error message or your 
software doesn’t install correctly, 
you may not have software 
installation privileges. Contact 
your System Administrator.

� If your printer icon (C80 Series) 
doesn’t appear in the Macintosh 
Chooser, you may have an 
extension conflict. Turn off any 
unnecessary extensions and restart 
your computer.
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� For Windows 2000 or XP, don’t 
select Block under Control Panel> 
System> Hardware> Driver 
Signing; select Ignore or Warn 
instead.

� Make sure Windows 98, Me, 2000 
or XP was preinstalled on your 
system. The USB Printer Device 
Driver may not install correctly if 
you’ve upgraded your system from 
an earlier version of Windows.

� Make sure the Universal Serial Bus 
Controller is working properly. See 
your Windows online help system 
for details. If it’s not working, 
contact your computer 
manufacturer.

� If you’re printing over a network, 
see your on-screen Reference Guide 
for instructions on configuring your 
printer for use on a network.

Printing Problems

The

 

 Ppower light is on, but nothing 
prints.

� Make sure the interface cable 
is connected securely and that 
the cable meets the system 
requirements on page 55 or 
page 56.

� Run a printer check as described 
on page 43. If the check page 
prints, make sure your printer 
software is installed correctly. 

� If you’re printing on a network, you 
need to set up your printer for 
network printing, as described in 
your on-screen Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

� Make sure the print head nozzles 
are not clogged. To clean the print 
head, see page 23.

� The printer won’t operate properly 
if it’s tilted or at an angle. Place it 
on a flat, stable surface that extends 
beyond the printer base in all 
directions.

Your printer makes noise when you 
turn it on or after it has been sitting 
for awhile.

Your printer is performing routine 
maintenance.
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Printing is too slow.

Make sure your system meets the 
requirements beginning on page 55. If 
you’re printing a high-resolution image, 
you need more than the minimum 
requirements listed. 

You may also need to:

� Clear space on your hard disk or 
run a defragmentation utility.

� Close open applications that you’re 
not using.

� Increase your system’s memory 
(RAM).

For the fastest printing, try these tips:

� Choose Black ink if your document 
doesn’t include color.

� Set the Quality/Speed slider to 
Speed.

� In the printer software’s Advanced 
dialog box, turn MicroWeave® off 
and/or turn High Speed on.

� Printing using a USB connection is 
faster than printing with a parallel 
connection.

� If you’re using a USB port, too 
many active USB devices may slow 
the printer. Disconnect USB 
devices that you’re not using.

� If you’re using the parallel port, 
enable ECP/DMA mode. See your 
computer documentation or 
contact the manufacturer for help.

Print Quality Problems

You see banding (light lines).

� The print head nozzles may need 
cleaning; see page 23 for 
instructions. 

� Make sure the Media Type setting 
matches the paper you loaded; see 
page 14 for guidelines.

� Make sure the printable side of the 
paper is face up. It’s usually whiter 
or shinier.

� The ink cartridges may need 
replacing. To replace an outdated 
ink cartridge, see page 31.

� Try using Automatic mode. See 
page 7 (Windows) or page 12 
(Macintosh) for instructions.

� Run the Print Head Alignment 
utility; see page 34 for instructions.
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� Set the paper thickness lever to the 

 

m position. Set the lever to the 

 

^ 
position when you print on thicker 
paper or envelopes. You may also 
need to turn off High Speed in the 
printer software.

Your printout is blurry or smeared.

� Make sure your paper isn’t damp or 
curled, or loaded face down (the 
printable side should be face up).

� Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

� Make sure your paper meets the 
specifications listed in the on-screen 
Reference Guide, and that it’s 
compatible with your printer. Use 
plain paper or one of the media 
types listed on the inside back 
cover.

� Use EPSON papers to ensure 
proper saturation and absorption 
of genuine EPSON inks. 
Non-EPSON media may not be 
compatible and may produce ink 
bleeding or pooling.

� Run the Print Head Alignment 
utility. See page 34 for instructions.

� Check the paper thickness lever 
position. If it’s in the 

 

^ position, 
your printer is set for thicker 
paper or envelopes and your image 
may smear. For most papers, set 
the paper thickness lever to the 

 

m position, as shown to the left.

� Remove each sheet from the output 
tray after printing, especially when 
you’re printing on transparencies.

� Let your print dry completely 
before you handle it. Prints made 
on Premium Glossy Photo Paper or 
Premium Semigloss Photo Paper 
take longer to dry. Follow the 
instructions included in your media 
pack.
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� Load a new sheet of plain paper and 
press the 

 

m paper button to eject it. 
Do this several times. If you still 
have a problem, ink may have 
leaked inside the printer. Open 
the printer cover and wipe the area 
circled in the illustration below 
with a soft, clean cloth.

Your printout is faint or has gaps in 
the image.

� The print head nozzles may need 
cleaning; see page 23 for 
instructions. 

� Run the print head alignment 
utility; see page 34 for instructions.

� The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 25. 

� Make sure the Media Type setting 
matches the paper you loaded. See 
page 14 for guidelines.

� Make sure your paper isn’t 
damaged, old, dirty, or loaded face 
down. If it is, reload a new stack of 
paper with the printable side up; it 
is usually whiter or shinier than the 
other side.

You see wrong or missing colors.

� If you’re printing color images, 
make sure both your application 
and printer software are set for 
color printing.

� The print head nozzles may need 
cleaning; see page 23 for 
instructions.

� The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 25.

� For best results, use genuine 
EPSON ink cartridges.

� Try turning off PhotoEnhance. 
Also check if you’re using a special 
effect that alters image colors, like 
Sepia. 

� Try using Automatic mode. See 
page 7 (Windows) or 12 
(Macintosh) for instructions.
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� The color profiles built into your 
printer software automatically 
reference your monitor profile. 
Make sure that your monitor is 
calibrated correctly.

� Try experimenting with the 
Gamma setting on the Advanced 
dialog box; see page 18 for 
information about accessing the 
Advanced dialog box.

� The colors produced by DuraBrite 
inks may look slightly different 
than those produced by ordinary 
dye-based ink.

� Due to the nature of pigment inks, 
lighting conditions can affect the 
appearance of printer output. For 
example, a print viewed in daylight 
may appear to have a slightly 
different color balance when viewed 
under tungsten lighting. Your 
printer software was designed to 
represent color accurately when 
prints are illuminated with a D50 
(daylight) light source.

� Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system to get as 
close as possible.

Your printout is grainy.

� Try using a higher quality paper.

� Set the Quality/Speed slider to the 
Quality setting in your printer 
software; see page 7 (Windows) or 
12 (Macintosh).

� You may need to increase the image 
resolution or print it in a smaller 
size; see your software 
documentation.

Some parts of your print are not as 
glossy as others.

Because of the nature of pigment inks, 
the degree of gloss may be uneven on 
glossy photo papers. Surface gloss 
decreases with greater pigment 
saturation.

Problems with Paper 
Feeding

Paper doesn’t eject fully or is 
wrinkled.

� If the paper doesn’t eject fully, you 
may have set the wrong paper size. 
Press the 

 

m paper button to eject 
the paper, then select the correct 
paper size in your application or 
printer software.

� If it’s wrinkled when it ejects, the 
paper may be damp or too thin.
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Paper doesn’t feed correctly or jams 
in the printer.

� If paper doesn’t feed, remove it 
from the sheet feeder, reload it 
against the right edge, then slide the 
left edge guide against the paper.

� If multiple pages feed at once, 
remove the stack from the sheet 
feeder, fan the edges to separate the 
sheets, and carefully reload it. Make 
sure the paper lies flat against the 
paper support.

� If paper jams, press the 

 

m paper 
button for several seconds to clear 
the jam. If that doesn’t work, turn 
off the printer and gently pull the 
paper forward (toward the output 
tray) to pull it out. Reload the 
paper and press the 

 

m paper button 
to resume printing.

If your paper jams frequently:

� Use new, smooth, high-quality 
paper, loaded printable side up.

� Don’t load paper above the arrow 
mark on the left edge guide.

� If you’re printing on both sides of 
the paper, try loading fewer sheets.

� Place the paper against the right 
edge and slide the left edge guide 
against it, but not too tightly. 

Solving Miscellaneous 
Printout Problems

The image is inverted.

Turn off Flip Horizontal in the printer 
software or the mirror setting in your 
application.

The printer prints blank pages.

� Make sure your printer is selected 
in your application, or as the active 
printer in the Macintosh Chooser.

� The print head nozzles may need 
cleaning. See page 23. 

The margins are incorrect.

� Make sure the paper settings in 
your printer software are correct for 
your paper size. See the on-screen 
Reference Guide for instructions.

� See your software documentation 
for instructions on choosing the 
correct margins for your paper size. 
The margins must be within the 
printable area of the page. See 
“Printer Specifications” in your 
on-screen Reference Guide.

Image size or position is incorrect.

Make sure paper and layout options are 
set correctly.
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You see incorrect characters.

� Make sure the interface cable is 
securely connected and meets the 
system requirements on page 55 or 
page 56. Then try printing again.

� Make sure your printer is selected 
in your application, or as the active 
printer in the Macintosh Chooser. 

� If you’re using a switch box with 
your printer, connect the printer 
directly to your computer.

The wrong number of copies prints.

Check the Copies setting in both your 
printer software and application. If 
you’re running Windows, check the 
Copies setting in the Windows Print 
dialog box.

There are scratch marks on your 
print.

If you’re printing on Premium Glossy 
or Premium Semigloss Photo Paper, 
prints have a tendency to scratch if not 
handled properly. Don’t place objects 
on top of your prints, and be careful 
not to scratch them with your 
fingernails. For best results, frame your 
prints under glass.
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Uninstalling Printer Software

If you need to uninstall and then reinstall your printer software, such as when you 
upgrade your computer operating system, follow these steps:

Uninstalling Windows Software

1. On your Windows Start menu, click Programs (All Programs for Windows XP).

2. Click Epson (or EPSON Printers), then EPSON Printer Software Uninstall.

3. Click OK on the next screen.

4. Follow the instructions on the screen to uninstall the printer software.

5. Restart your computer when you’re done. 

Uninstalling Macintosh Software

1. Insert your printer software CD-ROM in your drive. Then double-click the
 EPSON icon in your CD-ROM window. (You may need to double-click the 
 EPSON icon on your desktop to open the window.) You see the Main Menu.

2. Click Install Printer Driver, then click Continue.

3. On the installer screen, click the arrow in the Easy Install list at the top and select 
Uninstall. Then click the Uninstall button at the bottom and follow the 
instructions. When you’re finished, click Quit.

4. Restart your Macintosh. 
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Reinstalling Printer Software

Before reinstalling your printer software, first uninstall it as described on page 52. 
Then follow the instructions below. 

For detailed installation instructions, see your Start Here sheet. 
Remember that you don’t need to reinstall your on-screen 
Reference Guide, and you won’t see the license agreement.

Windows

1. Insert your printer software CD-ROM. Double-click  My Computer (for 
Windows XP, click Start first), and then double-click your  CD-ROM or 
DVD drive icon.

2. Double-click the  EPSON icon. The Main Menu appears.

3. Click Install Printer Driver and follow the instructions on your screen. Restart 
your computer when you’re done installing software.

Macintosh

1. Insert your printer software CD-ROM. Then double-click the  EPSON icon 
that appears on your desktop to open the CD-ROM window.

2. Double-click the  EPSON icon in your CD-ROM window. You see the 
Main Menu.

3. Click Install Printer Driver and follow the instructions on your screen. Restart 
your Macintosh when you’re done.

Where To Get Help

If you need help with your printer, see the contact information below. For help using 
any other software with your printer, see your software’s documentation for technical 
support information.
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EPSON Technical Support

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table:

To speak to a technical support representative, dial:

� U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

� Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Before you call, please have the following information ready:

� Product name (EPSON Stylus C80)

� Product serial number (located on the back of the printer)

� Proof of purchase (such as a store receipt) and date of purchase

� Computer configuration

� Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please 
call (800) 873-7766 for dealer referral.

Service Access

World Wide Web From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

Automated 
Telephone Services

A variety of automated help services are available 24 hours a 
day, seven days a week. To use these services, you must 
have a touch tone telephone and call (800) 922-8911. Your 
EPSON SoundAdvice Express Code is 71000. Use this 
code to quickly select the EPSON Stylus C80 in EPSON 
SoundAdvice.

SM
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Requirements and Notices

This chapter includes system requirements, safety instructions, legal notices, and other important 
information.

Windows System Requirements
To use your printer and its software, your system should have: 

� A Microsoft Windows compatible PC with a Pentium® or better processor, 200 MHz or faster, 
recommended

� Windows 95, Windows 98, Windows Me, Windows NT 4.x, Windows 2000, or Windows XP

� 32MB of RAM (64MB recommended)

� 100MB of free hard disk space (200MB or more recommended)

� VGA or better display adapter and monitor

� CD-ROM or DVD drive for installing the printer software

� Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, up to 10 feet 
long (3 meters); the cable must have a D-SUB, 25-pin, male connector for your computer, and a 
36-pin, Centronics® compatible connector for the printer.

USB connection: a computer running Windows 98, Windows Me or Windows 2000, with a 
Windows-compliant USB port and a shielded USB “AB” cable.

Using an improperly shielded USB cable may cause the printer to 
malfunction.
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Macintosh System Requirements
To use your printer and its software, your system should have: 

� An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

� Mac® OS 8.5.1 through 9.1 (Mac OS 9.1 recommended)

� 32MB of available RAM (64MB recommended)

� 100MB of free hard disk space (200MB recommended)

� VGA display or better

� CD-ROM or DVD drive for installing the printer software

� A shielded USB “AB” cable.

Using an improperly shielded USB cable may cause the printer to 
malfunction.
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ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR office equipment program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, and copiers in an 
effort to reduce air pollution caused by power generation.

Important Safety Instructions
Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

� Be sure to follow all warnings and instructions marked on the printer.

� Use only the type of power source indicated on the printer’s label.

� Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

� Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

� Do not let the power cord become damaged or frayed. 

� If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

� Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

� Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

� Leave enough room around the printer for sufficient ventilation.

� Do not place the printer near a radiator or heating vent or in direct sunlight.

� Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

� Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.
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� Always turn the printer off using the 

 

P

 

 power button. The 

 

P power light flashes briefly and then 
goes off. Don’t switch off the power strip or unplug the printer until the 

 

P power light is off.

� Do not block or cover the openings in the printer’s case or insert objects through the slots. 

� Except as specifically explained in this manual, do not attempt to service the printer yourself. 

� Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.

Ink Cartridge Safety Instructions

� Keep ink cartridges out of the reach of children and do not drink the ink. 

� Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

� Do not put your hand inside the printer or touch the cartridge during printing.

� Do not move the print head by hand. You may damage the printer.

� Install the ink cartridge immediately after you remove it from its plastic package. Leaving the 
cartridge unpacked for a long time before use can result in reduced print quality.

� Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

� Store ink cartridges in a cool, dark place.

� After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

� Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

� Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

� If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

� Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

� Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the 
FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment 
interface cable with this device. If this equipment has more than one interface connector, do not leave 
cables connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity
According to 47CFR, Part 2 and 15 for Class B Personal Computers and 

Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal 
Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: EPSON Stylus C80: P340A
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Epson America, Inc. Limited Warranty
What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the EPSON 
printer covered by this limited warranty statement, if purchased and used in the United States or 
Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the 
warranty period, please call the EPSON Connection  at (562) 276-7525 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will be fixed 
and sent back to you. You are responsible for packing the printer and for all costs to and from the 
Epson authorized service center. When warranty service involves the exchange of the printer or a part, 
the item replaced becomes Epson property. The replacement printer or part may be new or refurbished 
to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and 
quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling 
price of the covered printer. Exchange products and parts assume the remaining warranty period of 
your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover 
ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 

SM
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FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc.  

 

O

 

   P.O. Box 93012  

 

O

 

   Long Beach, CA 90809-3012 



63

Index

A

Accessories, 26, 54
Advanced settings, 18 to 19
Aligning print head, 34 to 35

B

Banding, 46 to 47
Blank pages, 50
Blurry images, 47
Browser, 2

C

Cable, printer, 55 to 56
Characters, incorrect, 51
Checking printer, 43
Cleaning

print head, 23 to 24
printer, 36
sheets, 23, 36

Color problems, 48
ColorSync setting, 18
Control panel, 41 to 42
Controlling printing, 9, 13
Copies setting, 51
Custom project types, 17 to 18

D

Default settings, Windows, 10
Digital Camera Correction setting, 17
Documentation, 1 to 4
Duplex printing, 20 to 22

E

Economy setting, 18
Electronic manual, 1, 2 to 4
Envelopes, printing on, 15
EPSON

accessories, 26, 54
help, 53 to 54
Monitor3, 13
papers, 14
Store, 26, 54

F

Faint images, 48
Filter, 17
Flip Horizontal setting, 50

G

Gamma setting, 18

H

Head Cleaning utility, 23 to 24
Help, EPSON, 53 to 54
High Speed setting, 46
High-resolution images, 16, 48

I

ICM (Image Color Matching) setting, 18
Incorrect characters, 51
Incorrect colors, 48
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Ink cartridge
checking ink levels, 27
replacing, 25 to 33
safety instructions, 58

Ink Jet Transparencies, 14
Ink level, 9, 25, 27, 31
Ink Monitor icon, 27
Ink setting, 8, 12
Installation problems, 44 to 45
Inverted image, 50

J

Jams, paper, 50

L

Layout problems, 50
Lever, thickness, 47
Lights, 41 to 42
Low-resolution images, 16

M

Macintosh
printer status, 13
printing with, 11 to 14
system requirements, 56
uninstalling software, 52
USB, 56

Maintaining printer, 23 to 36
Margins, incorrect, 50
Matte Paper - Heavyweight, 14
Media Type setting, 8, 12, 14
MicroWeave setting, 46
Mirror images, 50
Monitor3, EPSON, 13
Monitoring ink level, 9, 25, 31
Moving printer, 37

N

Network printing, 45
Noise, printer, 45
Nozzle check pattern, 24 to 25, 43

P

Page Setup dialog box, 11
Paper

feeding problems, 49 to 50
thickness lever, 47
type, setting, see Media Type setting

Photo Quality Ink Jet Paper, 14
PhotoEnhance setting, 16 to 17
Premium Glossy Photo Paper, 14
Premium Semigloss Photo Paper, 14
Previewing, 10, 14
Print dialog box, 7
Print head

aligning, 34 to 35
cleaning, 23 to 24

Print Head Alignment utility, 34 to 35
Print quality problems, 46 to 49
Printer

cable, 55 to 56
check, 43
cleaning, 36
control panel, 41 to 42
icon, 24, 27, 31, 34
maintaining, 23 to 36
noise, 45
problems, 41 to 43, 45 to 46
status, 9, 13
transporting, 37
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Printing
advanced, 18 to 19
controlling, 9, 13
duplex, 20 to 22
Macintosh, 11 to 14
on envelopes, 15
slow, 46
Windows, 7 to 10
with custom project types, 17 to 18
with PhotoEnhance, 16 to 17

Problems
installing software, 44 to 45
miscellaneous, 50 to 51
paper feeding, 49 to 50
print quality, 46 to 49
printing, 45 to 46

Progress Meter, 9
Project types, custom, 17 to 18

Q

Quality/Speed setting, 8, 12

R

Reference Guide, 1, 2 to 4
Reinstalling software, 53

S

Safety instructions, 57 to 58
Saving settings, 18
Semigloss media, 14
Service, 53 to 54
Slow printing, 46
Smears, 47
Software

problems, solving, 44 to 45
reinstalling, 53
uninstalling, 52

SoundAdvice, 54
Special effects, 18
sRGB setting, 18

Support, 53 to 54
System requirements, 55 to 56

T

Technical support, 53 to 54
Thickness lever, 47
Transparencies, 14
Transporting printer, 37
Troubleshooting, 39 to 50

U

Uninstalling software, 52
USB, 55, 56
Utilities

Head Cleaning, 23 to 24
Print Head Alignment, 34 to 35

W

Watermark, 10, 14
Windows

default settings, 10
printer status, 9
printing with, 7 to 10
system requirements, 55
uninstalling software, 52
USB, 55

World Wide Web, 54
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EPSON Ink Jet Papers

Use EPSON paper and inks to get the best results from your EPSON printer! EPSON papers are 
specially designed to work with EPSON quick drying inks. 

Premium Bright White Paper 

Premium Bright White Paper has a sleek, ultra-smooth surface, and 
108+ brightness. This paper delivers crisp black text and vivid, 
colorful images. It’s perfect for everyday printing—especially 
two-sided documents.

Double-Sided Matte Paper

Double-Sided Matte Paper is coated on both sides with a flat matte finish 
for photographic quality output. It’s the ideal media when you need 
high-quality double-sided printing for brochures, newsletters, or flyers.

Matte Paper - Heavyweight

Professional-looking, flat matte finish for printing photos and graphics on a 
non-glossy surface. Perfect for digital fine art work. Your prints last longer than 
with other media, especially when you display them under glass or store them 
in photo albums.

Featuring EPSON’s exclusive new DuraBrite™ ink technology for 
superior clarity, lightfastness, and water resistance.

For more information on other EPSON products and fun project 
ideas, look for the EPSON Print Lab  Series at 
www.epsonstore.com.

See the inside back cover for a list of EPSON papers and ordering information.
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How To Order EPSON Ink and Paper

To order EPSON ink cartridges and paper, call (800) 873-7766 or visit the EPSON Store at 
www.epsonstore.com (U.S. sales only). In Canada, please call (800) 873-7766 for dealer 
referral.

EPSON Ink Cartridges

Black T032120

Cyan T032220

Magenta T032320

Yellow T032420

EPSON Papers

Not all paper types match the Media Type setting names in your printer 
software. See the table on page 14 or the instructions that came with your 
paper to select the correct Media Type setting.

EPSON is always adding new papers to this list. Visit the EPSON Store at 
www.epsonstore.com and check out the latest media.

Paper name Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

Legal (8.5 x 14 inches) S041067

A4 (8.3 x 11.7 inches) S041061

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Archival Matte Paper Letter (8.5 x 11 inches) S041341

A4 (8.3 x 11.7 inches) S041342

EPSON Matte Paper - Heavyweight Letter (8.5 x 11 inches) S041257

A4 (8.3 x 11.7 inches) S041258

EPSON Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286

EPSON Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

A4 (8.3 x 11.7 inches) S041332

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

A4 (8.3 x 11.7 inches) S041063

EPSON Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106
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